Introduction

ELAN (EUDICO Linguistic Annotator) is an annotation tool that allows you to create, edit, visualize and search annotations for video and audio data. It was developed at the Max Planck Institute for Psycholinguistics, Nijmegen, The Netherlands, with the aim to provide a sound technological basis for the annotation and exploitation of multimedia recordings. ELAN is specifically designed for the analysis of language, sign language, and gesture, but it can be used by everybody who works with media corpora, i.e., with video and/or audio data, for purposes of annotation, analysis and documentation.

ELAN supports:

- display of a speech and/or video signal, together with its annotations;
- time linking of annotations to media streams;
- linking of annotations to other annotations;
- unlimited number of annotation tiers as defined by the users;
- different character sets;
- export as tab-delimited text files;
- im- and export between ELAN and Shoebox;
- search options.

This manual helps you to understand and use the features of ELAN.

Part I explains the installation process.

Part II is the user’s guide. It is organized around the following four topics:

- ELAN documents
- The screen display and the navigation through a document.
- Annotations.
- Search Options.

For each topic, basic information is given. Following that, the use of features is explained in a step by step way. It is recommended that you read the relevant chapter before starting to work with your own data.

Part III is the reference guide, i.e., it provides brief information on the following topics: mouse options, menu items, and shortcut keys. In addition, the key concepts of ELAN are defined and new features (compared to earlier versions) are listed.
Notation Conventions
The following notation conventions are used:

- Menü items, icons and screen displays are written in the font MS Sans Serif.
- (SHORTCUT) KEYS ARE WRITTEN IN SMALL CAPS.
- Step by step instructions on how to use a specific feature start with a caption on a gray background.
- Information on troubleshooting starts as follows: !

The screenshots used for illustration purposes throughout this manual are taken from corpora collected and annotated by Birgit Hellwig (on Goemai, a West Chadic language of Nigeria) and Gunter Senft (on Kilivila, an Austronesian language of Papua New Guinea).
Table of Contents

PART I: PRELIMINARIES ................................................................................................................. 6

1 INSTALLING ELAN ..................................................................................................................... 6

PART II: USER’S GUIDE .................................................................................................................. 7

2 ELAN DOCUMENTS ....................................................................................................................... 7

2.1 Basic Information: Media Files and Annotation Files ............................................................. 7

2.2 How to manage documents (using the File menu) ................................................................. 9
  2.2.1 Creating a new document .................................................................................................... 10
  2.2.2 Opening an existing document .......................................................................................... 12
  2.2.3 Closing a document ........................................................................................................... 13
  2.2.4 Saving a document ............................................................................................................ 13
  2.2.5 Creating automatic backups ............................................................................................ 14
  2.2.6 Importing a document from Shoebox ................................................................................. 14
  2.2.7 Exporting a document to Shoebox .................................................................................... 19
  2.2.8 Importing a Word Annotation Converter file ...................................................................... 22
  2.2.9 Exporting a document as a tab-delimited text file .............................................................. 24
  2.2.10 Exiting ELAN ................................................................................................................... 25

3 SCREEN DISPLAY AND NAVIGATION THROUGH A DOCUMENT .......................................... 27

3.1 Basic Information: The ELAN window ..................................................................................... 27
  3.1.1 The Video Viewer .............................................................................................................. 28
  3.1.2 The Waveform Viewer ....................................................................................................... 28
  3.1.3 The Subtitle Viewer ......................................................................................................... 29
  3.1.4 The Grid Viewer ............................................................................................................... 29
  3.1.5 The Timeline Viewer and the Interlinear Viewer .............................................................. 30
  3.1.6 The Menu options ............................................................................................................ 32
  3.1.7 The Media Player options ................................................................................................ 32
  3.1.8 The color coding ............................................................................................................... 33

3.2 How to change the display of the ELAN window ............................................................... 34
  3.2.1 Increasing/decreasing the size of the ELAN window .......................................................... 34
  3.2.2 Switching Viewers on/off ................................................................................................ 35
  3.2.3 Increasing/decreasing the size of Viewers ......................................................................... 36
  3.2.4 Switching tiers on/off ...................................................................................................... 36
  3.2.5 Rearranging the order of tiers .......................................................................................... 38
  3.2.6 Displaying a tier in the Subtitle Viewer ............................................................................. 38
  3.2.7 Changing the time resolution .......................................................................................... 40
  3.2.8 Changing the font size ..................................................................................................... 40

3.3 How to navigate through a document ...................................................................................... 42
  3.3.1 Accessing points in time .................................................................................................. 42
  3.3.2 Going to a selection .......................................................................................................... 43
  3.3.3 Jumping step by step through a document ...................................................................... 44
3.3.4  Viewing all annotations within one tier (Grid View).................................45
3.3.5  Jumping from annotation to annotation (Interlinear Viewer)......................48

3.4  How to play a document..................................................................................49
3.4.1  Playing a document......................................................................................49
3.4.2  Playing a selection.......................................................................................50
3.4.3  Playing around the crosshair/selection.......................................................50
3.4.4  Playing in slow motion...................................................................................51

4  ANNOTATIONS .................................................................................................52

4.1  Basic Information: Annotations, tiers and linguistic types.............................52

4.2  How to define a tier and its attributes...............................................................56
4.2.1  Adding new tiers .........................................................................................56
4.2.2  Changing tier attributes .............................................................................56
4.2.3  Creating/changing tier attributes...............................................................57
4.2.4  Deleting tiers...............................................................................................59

4.3  How to define a linguistic type.........................................................................61
4.3.1  Adding new linguistic types.........................................................................61
4.3.2  Changing linguistic types.............................................................................61
4.3.3  Creating/changing linguistic types.............................................................62
4.3.4  Deleting linguistic types................................................................................63

4.4  How to make a selection....................................................................................64
4.4.1  Making and saving a selection on an independent tier..................................64
4.4.2  Making and saving a selection on an independent tier while playing.............66
4.4.3  Making and saving a selection on a referring tier.......................................67
4.4.4  Deselecting a selection................................................................................68
4.4.5  Changing the time alignment of an existing selection...................................68
4.4.6  Activating and deactivating the Bulldozer mode..........................................70

4.5  How to enter annotations..................................................................................72
4.5.1  Entering annotations (into the Inline Edit box)..........................................72
4.5.2  Entering annotations (into the Edit Annotation box)....................................74
4.5.3  Entering annotations before/after other annotations..................................75
4.5.4  Modifying the content of annotations.........................................................77
4.5.5  Deleting annotations....................................................................................77
4.5.6  Entering annotations in different character sets........................................78

5  SEARCH OPTIONS .............................................................................................82

5.1  How to search annotations.................................................................................82
5.1.1  Searching......................................................................................................82
5.1.2  Displaying search results............................................................................85
5.1.3  Jumping from the search results to annotations........................................85

PART III: REFERENCE GUIDE .............................................................................87

1. The Mouse Options............................................................................................87
   Resizing Viewers...............................................................................................87
   Rearranging the order of tiers.........................................................................87
   Make a tier the active tier...............................................................................87
Accessing points in time .................................................................................................................. 87
Playing a document .......................................................................................................................... 87
Making a selection ............................................................................................................................... 87
Adding/modifying an annotation ........................................................................................................ 88

2. The Menu Items .......................................................................................................................... 88
File menu ............................................................................................................................................ 88
Edit menu .......................................................................................................................................... 88
Search menu ..................................................................................................................................... 89
View menu ......................................................................................................................................... 89
Player menu ....................................................................................................................................... 89
Selection menu .................................................................................................................................. 90
Options menu ..................................................................................................................................... 90
Help menu .......................................................................................................................................... 90

3. The Shortcut Keys ....................................................................................................................... 90
File options ...................................................................................................................................... 90
Playing a document .......................................................................................................................... 90
Working with annotations ............................................................................................................... 90
Working with selections .................................................................................................................. 91
Displaying shortcut keys .................................................................................................................. 91

4. Key concepts of ELAN ............................................................................................................... 91
Annotation file (*.eaf) ...................................................................................................................... 91
Media file (*.mpg/*.mov, *.wav) ...................................................................................................... 91
Annotation ........................................................................................................................................ 91
Tier .................................................................................................................................................. 91

5. Comparison to earlier versions .................................................................................................. 92

APPENDIX: REGULAR EXPRESSION SEARCH ............ 94
PART I: PRELIMINARIES

1 Installing ELAN
To install ELAN on your computer, go to http://www.mpi.nl/tools and follow the instructions. On this webpage, you will also find information about software and hardware requirements.
PART II: USER’S GUIDE
This part of the manual contains the user’s guide. It is organized as follows:

• ELAN documents (see section 2)
• Screen display and navigation through a document (see section 3)
• Annotations (see section 4)
• Search Options (see section 5)

It is recommended that you read the relevant section before starting to work with your own data.

2 ELAN documents

2.1 Basic Information: Media Files and Annotation Files
Every ELAN project consists of at least two files: one (or two) media file(s), and one annotation file.

(1) One (or two) media file(s):
• one video file (*.mpg, or *.mov)
• and/or one audio file (*.wav)

! Note: The *.mpg/*.mov file allows you to view the video and listen to the sound. If you want to view the waveform as well, you need to create an additional *.wav file through a conversion program that converts the audio data from the *.mpg file into a *.wav format. In the case of a *.mov file, it will not be possible to display the waveform.

! Note: The display of *.mov files (i.e., self-contained Cinepak-Quicktime-Movies) is supported for reasons of compatibility with older digitization formats. It is important that these are self-contained files, i.e., the video information needs to be contained within the *.mov file itself. If this is not the case, ELAN will not be able to display the file.

(2) One annotation file:
• an annotation file created by ELAN (*.eaf, “EUDICO Annotation Format”)

! Note: In an earlier version of ELAN, this annotation file had the file extension *.xml. In order to avoid confusion with other XML formats, the new extension *.eaf was adopted. If you have old *.xml ELAN files, please rename them manually into *.eaf.
or an imported annotation file. The following two import mechanisms are available:

- importing a file of the Shoebox format (with the extension *.txt)
- importing a WAC (“Word Annotation Converter”) file (with the extension *.wac.txt)

All information (e.g., the tier setup, the time alignment, the annotations) is saved to the annotation file only – never to the media file(s).

! Note: Never edit a media file that is associated with an annotation file. Doing so will corrupt the alignment of the time axis between the media and annotation files.

For the moment, the ELAN annotation file and the media file(s) have to share the same name. They only differ in their extensions: *.eaf (for the annotation file), *.mpg/*.mov (for the video file), and *.wav (for the audio file). Furthermore, they have to be in the same directory, e.g.:

Imported Shoebox files (*.txt) and Word Annotation Converter files (*.wac.txt) are not constrained in the same way as ELAN annotation files (*.eaf) are: they do not need to have the same name as their media files, and they can be located in different directories. However, all imported files (*.txt, *.wac.txt) can alternatively be saved as ELAN files (*.eaf) – in this case, they do follow the same constraints.

All annotation files (*.eaf, *.txt, *.wac.txt) can be exported as tab-delimited text files (*.txt). Furthermore, the imported Shoebox file (*.txt) can be exported back to Shoebox.
2.2 How to manage documents (using the File menu)

To start ELAN, do the following:

1. Double-click on the ELAN icon (on your desktop, or contained within the Java Web Start icon on your desktop).
   
The start dialog window is displayed, asking you what kind of document you want to open.

2. Click on the down arrow to open the list of available options, e.g.:

3. Click on:
   
   (a) Open existing … in case there is a media file (*.mpg/*.mov, *.wav) and an ELAN file (*.eaf) (see section 2.2.2).
   
   (b) Create new … in case there is a media file (*.mpg/*.mov, *.wav), but no annotation file (*.eaf, *.txt, *.wac.txt) (see section 2.2.1).
   
   (c) Import shoebox file … in case there is a media file (*.mpg/*.mov, *.wav) and a Shoebox file (*.txt) (see section 2.2.6).
   
   (d) Import WAC … in case there is a media file (*.mpg/*.mov, *.wav) and a “Word Annotation Converter” file (*.wac.txt) (see section 2.2.8).

4. Click OK to continue.

Different dialog windows appear and prompt you to enter the names and locations of the different files (see sections 2.2.2, 2.2.1, 2.2.6, and 2.2.8).

The ELAN window appears and displays the selected files.
Once you have started ELAN, use the File menu to open, create or import a second document.

The File menu supports the following options:

- New (section 2.2.1)
- Open (section 2.2.2)
- Close (section 2.2.3)
- Save (section 2.2.4)
- Automatic backup (section 2.2.5)
- Import Shoebox file … (section 2.2.6)
- Export as Shoebox file … (section 2.2.7)
- Import Word Annotation Converter file … (section 2.2.8)
- Export as tab-delimited text … (section 2.2.9)
- Quit (section 2.2.10)

### 2.2.1 Creating a new document

In case there is a media file (*.mpg/*.mov, *.wav), but no annotation file (*.eaf, *.txt, *.wac.txt), click on Create new … in the start dialog window (or on New in the File menu).

The New Transcription dialog window is displayed, e.g.:

Do the following:

1. Go to Author and enter the name of the person who will create the annotation document.
2. Click on **Browse** to browse to the directory that contains the media file (*.mpg/*.mov, *.wav). The **Open** dialog window is displayed:

3. Browse to the directory that contains the media file (*.mpg/*.mov, *.wav).

4. Double-click on the media file (*.mpg/*.mov, *.wav) to select it.

   Note: If both an *.mpg and a *.wav file exist, select the *.mpg file. ELAN will automatically create a connection to both files. If you select the *.wav file, ELAN will not be able to create a connection to the *.mpg file.

   In case of a *.mov file, it will not be possible to create a connection to a *.wav file.

   The **New Transcription** dialog window appears again, and the name of the selected media file is displayed in the box labeled **Media File**.

5. Click **OK** to create the new annotation file (*.eaf); otherwise click **Cancel** to exit the dialog window without creating a new file.

   An ELAN window containing the new document appears.
! Note: If there already exists an *.eaf file of the same name, ELAN will open the existing file – it will not create a new file. The following error message appears:

2.2.2 Opening an existing document

In case there is a media file (*.mpg/*.mov, *.wav) and an ELAN file (*.eaf), click on Open existing … in the start dialog window (or on Open in the File menu).

The Open dialog window is displayed:

Do the following:

1. Browse to the directory that contains the ELAN file (*.eaf).
2. Double-click on the annotation file to open it.

An ELAN window containing the document appears.

! Note: You can only open files of the EUDICO annotation format (*.eaf). If you try to open a file of a different format, the following error message appears:
2.2.3 Closing a document

If several documents are open, you can close some of the documents without having to exit the ELAN program.

Do the following to close a document:

1. Click on File menu.
2. Click on Close.

The document will be closed.

If you close the last open document, you will automatically exit the ELAN program (see section 2.2.10).

If you close a document without having saved the changes (see section 2.2.4), the Saving transcription dialog window appears, e.g.:

Click Yes to save the changes; click No to exit without saving; click Cancel to return to ELAN.

2.2.4 Saving a document

All documents can be saved as ELAN files (*.eaf, “EUDICO annotation format”). This includes documents that were created by ELAN itself (see sections 2.2.1 and 2.2.2) as well as documents that were imported into ELAN from Shoebox (see section 2.2.6) or Word (see section 2.2.8).

To save a document as an ELAN file (*.eaf), do one of the following:

(a) Either use the menu options:
   1. Click on File menu.
   2. Click on Save.

(b) Or use the shortcut key CTRL+S.

! Note: Please remember that all *.eaf files need to have the same name as their corresponding media files, and that they need to be located in the same directory (see section 2.1). In the case of files that were created by ELAN itself, ELAN automatically saves the file under the right name and into the right directory. In the case of imported files, you are prompted to enter the name and directory yourself.
2.2.5 Creating automatic backups
ELAN allows you to create automatic backup copies. To create backups, do the following:
1. Click on File menu.
2. Go to Automatic backup.
3. Click on the time interval after which ELAN should create the backup, e.g., after every 10 minutes.
A checkmark appears next to the selected time interval.

ELAN will automatically create backup copies, saving them with the extensions *.eaf.001, *.eaf.002, etc.

2.2.6 Importing a document from Shoebox
ELAN supports the import of documents from Shoebox, thereby allowing you to link transcribed and/or interlinearized documents to the time axis of media files. In order to import from Shoebox, you need the following three files:
• the Shoebox file (*.txt);
• the media file(s) (*.mpg/*.mov, *.wav);
• the corresponding Shoebox database type file (*.typ).

! Note: If you do not know the Shoebox database type file, do the following:
1. Open the Shoebox *.txt file in Shoebox. Make sure it is the active window (click on it to activate it).
2. Click on Database menu.
3. Click on Properties .... The Database Type Properties dialog box appears. The name of the database type is displayed in the header, e.g.:
4. Locate the directory of the database type file (e.g., “texts.typ” in the above illustration). It is probably located in the directory “My Shoebox Settings”.

To import a Shoebox file into ELAN, do the following:

1. Click on Import shoebox file … in the start dialog window (or on Import Shoebox file … in the File menu).

   The Import Shoebox dialog box appears.

2. Specify the name and directory of the three files, e.g.:

   ! Note: If both an *.mpg and a *.wav file exist, select the *.mpg file. ELAN will automatically create a connection to both files. If you select the *.wav file, ELAN will not be able to create a connection to the *.mpg file.

   In case of a *.mov file, it will not be possible to create a connection to a *.wav file.

   ! Note: Unlike *.eaf documents, the Shoebox file and the media file(s) do not need to have the same name, and they do not need to be in the same directory (see section 2.1).

3. Click OK to import the file; otherwise click Cancel to exit the dialog box without importing the file.

   An ELAN window containing the imported Shoebox file appears.
ELAN imports Shoebox files according to the following conventions:

(1) The Shoebox field markers are imported as ELAN tiers. The tier label is identical to that of the field marker, except for the added extension @'Speaker-ID'.

This addition is necessary because ELAN and Shoebox differ in how they code information about multiple speakers:

- In ELAN, each speaker is coded on a separate tier.
- In Shoebox, all speakers are coded in the same field, and their identity is specified in a separate field.

When importing texts by multiple speakers, ELAN splits each Shoebox field into several ELAN tiers (one for each speaker) and adds the speaker-ID to the tier label.

If speaker information is not specified in the Shoebox file, the extension @unknown is added.

The following screenshot illustrates how ELAN treats texts by multiple speakers:

! Note: In this release, ELAN can only read speaker information if it is coded in a Shoebox field labeled \EUDICOp (see illustration above). If this field is not present, or if speaker information is coded in a different field, ELAN will
assume that there is only one speaker. I.e., if you have multiple speakers and if you want ELAN to assign them to separate tiers, do the following:

1. For every Shoebox record, add the field marker \EUDICO.
2. For every Shoebox record, enter the relevant speaker-ID into this field.

! Note: When the file is exported back to Shoebox (see section 2.2.7), the extension @'Speaker-ID' is automatically dropped from the field marker, and the Shoebox records are sorted according to their record marker (e.g., in the above illustration, “LIGYA-002” is sorted before “LIGYA-003” etc.)

(2) Based on the information contained in the Shoebox database type file, the tiers are brought into a hierarchical relationship and are assigned to linguistic types (see section 4.1 for details of tier hierarchies and linguistic types):

- The Shoebox record marker is assigned to a type labeled main-tier (assigned to the stereotype None), i.e., it is an independent, time-alignable parent tier.
- The transcription and parsing fields of Shoebox are assigned to a type labeled symbolic-subdivision-tier (assigned to the stereotype Symbolic Subdivision), i.e., they are referring tiers that can be subdivided into smaller units.
- All other fields are assigned to a type labeled symbolic-association-tier (assigned to the stereotype Symbolic Association), i.e., they are referring tiers that cannot be subdivided into smaller units.

For example:

! Note: These three linguistic types are created by ELAN for imported Shoebox files. In principle, you could change the assignment and create new
linguistic types, e.g., you could assign the \text{tx} tier to \textbf{Time Subdivision} instead of \textbf{Symbolic Subdivision} (see section 4.1). However, for this version of ELAN, we recommend to keep the default assignments as changes may create problems for exporting files back to Shoebox.

(3) All SIL IPA characters are converted into Unicode characters during import. If you export the file back into Shoebox (see section 2.2.7), the Unicode characters will be converted back into SIL IPA characters.

(4) The imported Shoebox file does not yet have the correct timecode information. Instead, ELAN automatically assigns each Shoebox record to a one second time interval, as in the following illustration:

![Time alignment illustration](image)

The time alignment has to be done manually for each Shoebox record. Do the following:

1. Activate the Bulldozer mode: Click on \textit{Options} menu, click on \textit{Bulldozer Mode} (see section 4.4.6 for the two available modes).

   ! Note: If you do not activate the Bulldozer mode, you will inadvertently overwrite and thereby delete existing annotations. Make sure that the label \textit{Bulldozer Mode} appears in the header of the ELAN window.

2. Click on the first annotation on the parent tier (i.e., the first Shoebox record). It appears in a dark blue frame.

3. Modify the boundaries of that annotation, so that they are aligned with the correct time interval (see section 4.4.5 for ways of modifying boundaries).

4. Press \texttt{CTRL}+\texttt{ENTER} to save the new time interval.

   The parent annotation (together with all its referring annotations) is assigned to the new time interval. All other parent annotations are moved to the right.

5. Repeat steps 2 to 4 for each parent annotation.
19

The following screenshot illustrates steps 1 to 4:

1. activate the Bulldozer mode
2. select a parent annotation
3. change and save the time alignment
4. all other annotations are moved to the right

! Note: After you have done the time-alignment, you can export the file back to Shoebox – in this case, the timecode information will be kept (see section 2.2.7). If you then re-import the file back into ELAN, ELAN automatically assigns the Shoebox records to their correct time intervals.

! Note: An imported Shoebox file can be saved as an ELAN file (see section 2.2.4), exported back into Shoebox (see section 2.2.7), or exported as a tab-delimited text (see section 2.2.9).

2.2.7 Exporting a document to Shoebox
All Shoebox and Word Annotation Converter files that were imported into ELAN (see sections 2.2.6 and 2.2.8) can be exported into Shoebox. In this case, the timecode information is kept.

! Note: Only original Shoebox/Word Annotation Converter files can be exported. It is not yet possible to export *.eaf files to Shoebox.

To export a file into Shoebox, do the following:
1. Click on File menu.
2. Click on Export as Shoebox file ....

The Shoebox Export dialog box appears.
3. Specify the name and directory of the exported file, e.g.:

4. Click OK to export the file; otherwise click Cancel to exit the dialog box without exporting the file.

The file is exported as a *.txt file.

! Note: If there already exists a file of the same name, ELAN will ask you whether or not it should overwrite the existing file, e.g.:

5. Open the exported file in Shoebox.

! Note: An exported Word Annotation Converter file cannot be opened directly in Shoebox. It needs to be imported.

It contains the following information:

(1) All tiers and annotations.

Each ELAN parent annotation (including all its referring annotations) corresponds to one Shoebox record. E.g., in the illustration below, the ELAN parent annotation “Ligya-001” corresponds to the Shoebox record “Ligya-001”.

(2) The timecode information for each parent annotation.

Each ELAN parent annotation (i.e., each Shoebox record) contains the additional field markers \EUDICOt0 and \EUDICOt1 (i.e., the begin and end time of the parent annotation).
This timecode information allows you to import the Shoebox file back into ELAN, without having to manually re-align the file (see section 2.2.6).

! Note: Shoebox does not support Unicode encoding. I.e., if you have modified your annotations in ELAN using a language encoding other than “English (United States)”, these characters will not be displayed correctly in Shoebox.
2.2.8 Importing a Word Annotation Converter file

ELAN supports the import of Word Annotation Converter files.

The Word Annotation Converter\(^1\) is a conversion program that allows you to convert Microsoft Word files (*.doc) into XML files of the Word Annotation Converter format (*.wac.txt). It will be made available shortly under http://www.mpi.nl/tools. For example:

Microsoft Word file (*.doc): containing interlinearized text; the lines are differentiated through formatting (underline, bold, regular, italic)

converted XML file (*.wac.txt): each line of the interlinear text is marked with an XML tag

The converted file (*.wac.txt) can then be imported into ELAN. To import such a file, do the following:

1. Click on Import WAC … in the start dialog window (or on Import Word Annotation Converter file … in the File menu).

The Import WAC dialog box appears.

---

\(^1\) Copyright © Markus Kramer and Peter Wittenburg (MPI for Psycholinguistics). This material may be distributed only subject to the terms and conditions set forth in the Open Publication License, v1.0 or later (the latest version is presently available at http://www.opencontent.org/openpub/).
2. Enter the name and location of the following three files:
   - the WAC (Word Annotation Converter) file (*.wac.txt)
   - the Shoebox (database) type file (*.typ) (see section 2.2.6 for details on Shoebox files)
   - the media file (*.mpg/*.mov, *.wav)

3. Click **OK** to import the file; otherwise click **Cancel** to exit the dialog box without importing the file.

   An ELAN window containing the imported Word Annotation Converter file (*.wac.txt) appears, e.g.:

   ![Imported file in ELAN](image)

   ! Note: The Word Annotation Converter file is imported according to certain conventions. See section 2.2.6 for details.

   ! Note: An imported Word Annotation Converter file can be saved as an ELAN file (see section 2.2.4), exported into Shoebox (see section 2.2.7), or exported as a tab-delimited text (see section 2.2.9).
2.2.9 Exporting a document as a tab-delimited text file

All documents can be exported into a tabular format for purposes of further analysis and/or printing. This includes documents that were created by ELAN itself (see sections 2.2.1 and 2.2.2) as well as documents that were imported into ELAN from Shoebox (see section 2.2.6) or Word (see section 2.2.8).

Do the following:

1. Click on File menu.

2. Click on Export as tab-delimited text ....

   The Export as tab-delimited text dialog window is displayed, e.g.:

3. By default, ELAN exports all annotations, but it is possible to restrict the export process to selected annotations. The following three options are available:

   (a) Export only those annotations that correspond to a selected time interval. Do the following:

      1. In the ELAN window, select the desired time interval (see section 4.4.1).

      2. In the Export as tab-delimited text dialog window, click in the box to the left of Restrict to selected time interval. A checkmark appears indicating that this option has been selected.

   (b) Export only those annotations that are contained on particular tiers. Do the following:

      In the Export as tab-delimited text dialog window, select those tiers that you want to export. A checkmark appears next to any selected tier.

   (c) Export only those annotations that (a) correspond to a particular time interval and (b) are contained on particular tiers. To do this, combine the two steps under (a) and (b) above.
4. Click OK to start the export process; otherwise click Cancel to exit the dialog box without exporting the annotations.

A message appears to inform you that the file has been exported. The exported file has the extension *.txt. It has the same name as the annotation file, and it is written into the same directory as the annotation file.

! Note: If a file of that name already exists in the directory, it is overwritten without further warning.

The exported file contains the following information: begin time of each annotation, end time, total length, content, and tier. It can be opened with any program that can handle tab-delimited texts, e.g., Microsoft Excel.

2.2.10 Exiting ELAN

To exit ELAN, do one of the following:

(a) Either use the menu options:
   1. Click on File menu.
   2. Click on Quit.

(b) Or use the shortcut key CTRL+Q.
If you exit ELAN without having saved the changes (see section 2.2.4), the Saving transcription dialog window appears, e.g.:

![Saving transcription dialog window]

Click **Yes** to save the changes; click **No** to exit without saving; click **Cancel** to return to ELAN.
3 Screen display and navigation through a document
Whenever you open, create or import a document, the ELAN window appears. This section introduces you to the setup of the ELAN window (section 3.1), and explains the navigation through it (sections 3.2, 3.3, 3.4).

3.1 Basic Information: The ELAN window
The ELAN window displays the Menu bar, the Media Player options, and up to four Viewers, e.g.:

All Viewers are synchronized and thus display the same point(s) in time. I.e., whenever you access a point in time in one of the Viewers, all the other Viewers will immediately jump to the corresponding point in time.

In all Viewers, color coding is used to facilitate the orientation in the document.

This section introduces the setup of the Viewers, the Menu bar, the Media Player options and the color coding. Detailed information about how to navigate through the ELAN window follows in the subsequent sections.
3.1.1 The Video Viewer

The Video Viewer displays the video image (of the *.mpg/*.mov file).

3.1.2 The Waveform Viewer

The Waveform Viewer displays the waveform of the audio file (*.wav). Above and below the waveform, timecode information is displayed. While listening to the sound, a red vertical bar, the crosshair, moves through the waveform and indicates which part of the waveform corresponds to the current point in time. Furthermore, whenever you have selected a time interval, the corresponding part of the waveform will be highlighted in light blue color.

Note: In the case of video files, the waveform is only displayed if there exists an additional *.wav file (see section 2.1). If this is not the case, the Waveform Viewer will not be available.
Note: On slower machines, the Waveform Viewer may not always update properly when moving to the next page.

3.1.3 The Subtitle Viewer

The Subtitle Viewer displays the currently ‘active tier’ – a tier that is defined by you. You can turn any one of the tiers in the Timeline or Interlinear Viewer into the active tier (by dragging and dropping the tier label to the Subtitle Viewer, or by selecting from the pull-down menu that pops up after right-clicking on an annotation in the Timeline or the Interlinear Viewer).

During playback, the Subtitle Viewer displays the annotations of the active tier one by one.

3.1.4 The Grid Viewer

The Grid Viewer displays the content as well as the begin and end time of all annotations from a single tier. You have to activate this Viewer through selecting Grid Viewer from either the View menu or from the pull-down menu that pops up after right-clicking on an annotation in the Timeline or the Interlinear Viewer.

It is possible to select annotations within the Grid Viewer (by clicking on them), or to edit them (by double-clicking on them).
3.1.5 The Timeline Viewer and the Interlinear Viewer

All annotations are displayed in the Timeline Viewer or the Interlinear Viewer. Only one of the two Viewers can be switched on at a time.

The Timeline Viewer is the default Viewer, i.e., it is automatically active whenever ELAN starts. It displays the tiers and their annotations, whereby each annotation corresponds to a specific time interval. Above and below the tiers, timecode information is displayed. During playback, a red vertical bar, the crosshair, moves through the annotations and indicates which annotation corresponds to the current point in time. Furthermore, whenever you have selected a time interval, it will be highlighted in light blue color; and whenever you have selected an annotation, it will be highlighted in a dark blue frame. At the bottom of the Timeline Viewer a scrollbar is displayed that allows you to scroll forward/backward in time on a second by second basis.

In the Timeline Viewer you can (a) select and modify time intervals (see section 4.4) and (b) enter annotations (see section 4.5).

The Interlinear Viewer offers an alternative perspective on the tiers and their annotations. It is not the default Viewer, i.e., if you want to access it, you have to switch it on manually (using the View menu options). Switching it on, will automatically switch off the Timeline Viewer.

! Note: The Interlinear Viewer is available for imported Shoebox files (see section 2.2.6), but it is not always available for *.eaf files (only for those *.eaf files that have an interlinear structure comparable to that of Shoebox files).
The following screenshots compare how information is displayed in the two Viewers.

**Timeline Viewer:**

- Current position of cross-hair (in red color)
- Selected annotation (on tier mb)
- Time interval of annotation on parent tier (on tier ref)

**Interlinear Viewer:**

- Click here to move forward/backward to the next annotation

Whenever the Interlinear Viewer is switched on, it displays an annotation block (i.e., an independent, time-alignable parent annotation together with its referring annotations, see section 4.1). To move forward/backward to the next block, click on the arrow icons at the bottom of the Viewer. During playback, the Viewer automatically moves forward to the next annotation block.

The Interlinear Viewer differs from the Timeline Viewer in that it does not allow to modify the time interval or to enter new annotations. It is similar to the Timeline Viewer in that it allows to edit existing annotations.
3.1.6 The Menu options

The following Menu options are available at the top of the ELAN window:

- **File**: use this menu to open, create, save, im-/export or exit a document (see section 2).
- **Edit**: use this menu to define, modify and delete annotations, tiers and linguistic types (see section 4).
- **Search**: use this menu to search for text (see section 5).
- **View**: use this menu to modify the display of the ELAN window (see section 3.2).
- **Player**: use this menu to choose ‘play’-related commands (see sections 3.3, 3.4).
- **Selection**: use this menu to choose ‘selection’-related commands (see section 3.3, 3.4).
- **Options**: use this menu to (de)activate the Bulldozer mode (see section 4.4.6) and view information on tier dependencies (see section 4.1).
- **Help**: use this menu to display the shortcut keys and read information about ELAN.

3.1.7 The Media Player options

With the Media Player options, you can control the playback of the file. The following options are available at the bottom and at the left side of the ELAN window:

- The timecode box displays the timecode in the following format: “hours:minutes:seconds.milliseconds”. It can be used to access points in time (by clicking on it).
- The **Play/Pause** icon starts/pauses the playback.
- The slider at the left side of the ELAN window allows you to control the playback rate.
3.1.8 The color coding

In all its displays, ELAN makes use of recurring colors in order to facilitate the orientation in the document. The following colors are used:

- Red: Position of the crosshair (i.e., current point in time);
- Light Blue: Selected time interval;
- Dark Blue: Selected annotation.
- Black (and long segment boundaries): Annotations that can be aligned to the time axis.
- Yellow (and short segment boundaries): Annotations that cannot be aligned to the time axis.

For example:
3.2 How to change the display of the ELAN window

The ELAN window setup as described and illustrated in section 3.1 above is the default display. But you can easily change the display according to your needs. The following options are available:

- increasing/decreasing the size of the ELAN window (section 3.2.1);
- switching Viewers on/off (section 3.2.2);
- increasing/decreasing the size of Viewers (section 3.2.3);
- switching tiers on/off (section 3.2.4);
- rearranging the order of tiers (section 3.2.5);
- displaying a tier in the Subtitle Viewer (section 3.2.6);
- changing the time resolution (section 3.2.7);
- changing the font size (section 3.2.8).

3.2.1 Increasing/decreasing the size of the ELAN window

The size of the ELAN window can be increased or decreased. Do one of the following:

(a) Go with the mouse to the borders of the ELAN window. The mouse will turn into a double-headed arrow. Click and move it to increase/decrease the size of the window.

(b) In the top right corner of the ELAN window, click on the Maximize icon to activate the full-screen modus; click on the Restore Down icon to return to the previous size.

! Note: Resizing the ELAN window during playback will cause JMF (Java Media Framework) to behave unpredictably. Please resize the window only after playback has stopped.
3.2.2 Switching Viewers on/off

Depending on the type of media file, ELAN automatically displays up to four of the Viewers (Video, Waveform, Subtitle and Timeline Viewer). Each of them can be switched on or off. In addition, the Grid Viewer can be activated and the Timeline Viewer can be replaced by the Interlinear Viewer. Note that it is not possible to activate both the Timeline and the Interlinear Viewer at the same time.

To switch Viewers on/off, do the following.

1. Click on View menu. A menu appears, displaying available, non-available and (de)activated Viewers, e.g.:

2. Click on the Viewer you want to switch on/off. A checkmark appears next to any activated Viewer. Viewers without a checkmark are not displayed in the ELAN window.

! Note: If a media file is not available (e.g., the *.mpg/*.mov file in case of audio data, or the *.wav file in case of some video data), the corresponding Viewer is not available either. In a similar way, if the annotations do not have an interlinear structure, the Interlinear Viewer will not be available.

! Note: If you want to view neither the Timeline nor the Interlinear Viewer, click on None.
3.2.3 Increasing/decreasing the size of Viewers

The size of all Viewers (except for the Video Viewer) can be increased and decreased relative to the size of other Viewers. Do one of the following:

(a) **Use the up/down-arrows.**

Click on the up/down-arrow to increase/decrease the size of the corresponding Viewer.

(b) **Use the mouse.**

Go with the mouse to the split-pane. The mouse will turn into a double-headed arrow. Click and move it up/down to increase/decrease the size of the corresponding Viewer.

3.2.4 Switching tiers on/off

By default, ELAN automatically displays all available tiers, but each tier can be switched on or off manually, allowing you to focus only on the tiers of interest for the task at hand.

To switch tiers on/off, do one of the following:

(a) **Use the pull-down menu.**

1. In the Timeline Viewer, right-click somewhere at the height of the tier that you want to switch off. A pull-down menu appears.

2. In the pull-down menu, click on **Hide tier**. The corresponding tier is switched off.
(b) Use the View menu.

1. Click on View menu.

2. Go to Visible Tiers. The labels of all available tiers are displayed, e.g.:

3. Click on the tier you want to switch on/off.

   A checkmark appears next to any tier that is activated. Tiers without a checkmark are not displayed in the ELAN window.

   Alternatively, you can switch all tiers on (click on Reset All) or off (click on None).

Tiers are ordered according to the following principles:

- If you switch a tier on, it will be put underneath all other tiers.
- If you click on Reset All, the tiers will appear in their original order.
3.2.5 Rearranging the order of tiers

Within the Timeline or Interlinear Viewer, you can rearrange the order in which the tiers are displayed. Do the following:

1. Click on the tier label. Keep the mouse button clicked.
2. Drag the tier label to its new location.
3. Release the mouse button. The tiers are now displayed in the new order.

If you exit the document, ELAN will save the order of tiers in the following way: first, all activated tiers (in the order as they appear in the Timeline or Interlinear Viewer), followed by all non-activated tiers in alphabetical order.

3.2.6 Displaying a tier in the Subtitle Viewer

It is possible to display one of the tiers as a subtitle or ‘active tier’ in the Subtitle Viewer.

To turn a tier into the active tier, do one the following:

(a) Click on the tier label

In the Timeline or Interlinear Viewer, click on the tier label. The corresponding tier will be made the active tier.
(b) Drag and drop the tier label.

1. In the Timeline or Interlinear Viewer, click on the tier label. Keep the mouse button clicked.
2. Drag the tier label to the Subtitle Viewer.
3. Release the mouse button. The selected tier is now displayed in the Subtitle Viewer.

(c) Use the pull-down menu.

1. In the Timeline Viewer, right-click somewhere at the height of the tier that you want to make the active tier. A pull-down menu appears.
2. In the pull-down menu, click on Active tier. The corresponding tier will be made the active tier, e.g.:

   ! Note: It is useful to turn the tier you are currently working on into the active tier because (a) the Subtitle Viewer is bigger and supports line wrapping (which makes it easier to read along during playback) and (b) the menu item File / New annotation here is only available for the active tier.
3.2.7 Changing the time resolution

The default resolution for the Waveform and the Timeline Viewer is 100%, corresponding to 10 milliseconds per pixel. The resolution can be changed simultaneously for both Viewers. Do the following:

1. Click on View menu.
2. Go to Resolution. The following menu appears:

3. Click on a resolution rate to select it. A checkmark appears next to the selected resolution rate.
   - Click on a lower percentage to get a finer resolution.
   - Click on a higher percentage to get a wider resolution.

3.2.8 Changing the font size

The default font size is 16 pt., but it can be changed globally for the whole document. Do the following:

1. Click on View menu.
2. Go to Font size. The following menu appears:
3. Click on a font size to select it. A checkmark appears next to the selected font size.

Note: In a later release it will be possible to set the font size individually per tier, and possibly per character. In this version, font size can only be changed globally.
3.3 How to navigate through a document
ELAN supports the following options for navigating through a document:

- accessing points in time (section 3.3.1);
- going to a selection (section 3.3.2);
- jumping step by step through a document (section 3.3.3);
- viewing all annotations within one tier (Grid View) (section 3.3.4);
- jumping from annotation to annotation (Interlinear Viewer) (section 3.3.5).

! Note: All Viewers are synchronized in time, i.e., when you navigate to a specific point or selection in one Viewer, all other Viewers will immediately jump to the corresponding point or selection:

- The Video Viewer will display the corresponding video frame (or, in case of a selection, the first frame of that selection).
- The Waveform Viewer will display the corresponding waveform.
- The Subtitle, Timeline and Interlinear Viewers will display the corresponding annotation(s).

3.3.1 Accessing points in time
To access a point in time, do one of the following:

(a) Use the timecode box.

Do the following:

1. Click on the timecode box in the lower left corner of the ELAN window. The Goto dialog window appears.
2. Enter the timecode in the following format: “hh:mm:ss.sss” (hours:minutes:seconds.milliseconds). The crosshair jumps immediately to the selected timecode.

You can omit part of the timecode information:

- If the digits are “00”, you can omit “hours:”, “hours:minutes:”, or “hours:minutes:seconds.”
- It is optional to specify “.milliseconds”.

! Note: The character preceding the milliseconds is a dot, not a colon.

(b) Use the scrollbars or the crosshair.

Do one of the following:

- Either click somewhere in the Timeline, Waveform or Grid Viewer. The crosshair will jump to that point.

- Or click on the scrollbar of the Timeline Viewer to scroll backward/forward second by second. Alternatively, click on the arrows to the left (backward) and right (forward) of the scrollbar

! Note: If you click on the time axis that is displayed to the top and bottom of the Timeline Viewer (i.e., the line that displays timecode information), the crosshair will not respond. Click somewhere well within the Viewer.

3.3.2 Going to a selection

If you have made a selection (see section 4.4), you can move the crosshair to the beginning of that selection from anywhere within the file.

1. Click on Selection menu.

2. Click on Go to selection. The crosshair moves to the beginning of the selection.
3.3.3 Jumping step by step through a document

It is possible to move the crosshair back and forth step by step. Do one of the following:

(a) Either use the menu options:
   1. Click on Player menu.
   2. Click on:
      - Forward to go one step forward.
      - Rewind to go one step back.

(b) Or use the shortcut keys:
   - CTRL+F to go one step forward.
   - CTRL+R to go one step back.

The stepsize can be altered. Do the following:
   1. Click on Selection menu.
   2. Go to Step mode. The following menu appears:

   Select an option from the menu:
   - Audio: The stepsize for audio data is 10 milliseconds, corresponding to one pixel in the default resolution (of 100%).
   - PAL/NTSC: The stepsize for video data corresponds to one PAL or NTSC video frame, allowing a frame-by-frame stepping through a recording.

   3. Click on a step mode to select it. A checkmark appears next to the selected step mode.
3.3.4 Viewing all annotations within one tier (Grid View)

ELAN allows you to view all annotations from a single tier, and to then select one annotation and jump to it.

To activate the Grid Viewer, do one of the following:

(a) **Use the mouse.**

1. In the Timeline Viewer, right-click at the height of the tier whose annotations you want to view. A pull-down menu appears.
2. In the pull-down menu, click on **Grid Viewer**. The **Grid View** window opens and displays all annotations of that tier.

(b) **Use the **View** menu.**

1. Click on **View** menu.
2. Click on **Grid Viewer**. The Grid Viewer opens and displays the annotations of the active tier.
The structure of the Grid View window is as follows:

In addition, the following menu items are available:

- **File** menu: Use this menu to exit the Grid View window.
- **Select Tier** menu: Use this menu to view annotations on another tier. Do the following:
  1. Go to **Select Tier**.
  2. Select a tier from the pull-down menu. The Grid Viewer displays the annotations of that tier.

![Diagram of Grid View window with annotations and menu options]
You can use the Grid View window to navigate to an annotation in the ELAN window. You have the following two options:

(a) **Move the crosshair to the beginning of an annotation.**

Do the following:

1. In the Grid View window, click with the mouse button on an annotation.

   A red symbol appears next to the annotation in the Grid View window, and the crosshair moves to the beginning of that annotation in the ELAN window.

(b) **Select a time interval.**

Do the following:

1. In the Grid View window, click with the mouse button on the first annotation that you want to select.

2. Keep the mouse button clicked and drag it to another annotation.

   In the Grid View window, all selected annotations are highlighted in light blue color. In the ELAN window, the corresponding time interval is selected and highlighted in light blue color (starting with the beginning of the first annotation and ending with the endpoint of the last).

! Note: You cannot jump directly from the Grid View window to the Timeline Viewer of the ELAN window. Instead, click somewhere in the ELAN window to return there.
3.3.5 Jumping from annotation to annotation (Interlinear Viewer)

In the Interlinear Viewer, you can jump from one annotation block forward/backward to the next block. Do one of the following:

(a) Click on the arrow key at the bottom left corner of the Interlinear Viewer to move to the previous annotation block.

(b) Click on the arrow key at the bottom right corner of the Interlinear Viewer to move to the next annotation block.
3.4 How to play a document
ELAN supports the following options for playing a document:

• playing a document (section 3.4.1);
• playing a selection (section 3.4.2);
• playing around the crosshair/selection (section 3.4.3);
• playing in slow motion (section 3.4.4).

3.4.1 Playing a document
During playback, the red crosshair moves through the Waveform, Timeline, Interlinear and Grid Viewers, indicating the point in time that is being replayed. If you stop the playback, the crosshair will stop at this point in time. The playback will resume from this point and will continue until the end of the document, or until the playback is paused again.

Make use of either one of the following three options to start/pause the playback:

(a) Use the Play/Pause button located to the left bottom corner of the ELAN window:

1. Click on the Play icon to start playback. After the playback starts, the Play icon turns into a Pause icon.

2. Click the Pause icon to pause the playback again.

(b) Use the menu options:

1. Click on Player menu.
2. Click on Play/pause to start the playback. Click again on Play/pause to pause the playback.

(c) Use the Shortcut key CTRL+SPACE (on the Mac: CTRL+P) to start the playback. Use it again to pause the playback.

! Note: If two or more ELAN documents are open at the same time, the sound may not work properly. Should this happen, close all documents except for one.
3.4.2 Playing a selection

It is possible to play only a selected part of the document. Do the following:

1. Make a selection (see section 4.4), or click on an annotation.
2. To play the selection, do one of the following:
   (a) Either use the menu options.
      1. Click on Selection menu.
      2. Click on Play selection.
   (b) Or use the shortcut key CTRL+L.

The selected part is played immediately. To listen to the selection again, repeat step 2.

! Note: If the crosshair is positioned somewhere within the selection (i.e., if it had been manually moved forward or backward, see section 3.3.3), playback will start from its position and stop at the end of the selection. Otherwise, the whole selection will be played.

! Note: It is currently not possible to play a selection that is shorter than 80 milliseconds.

3.4.3 Playing around the crosshair/selection

It is possible to play (i) a few (milli)seconds before and after the crosshair (the red vertical bar), or (ii) a few (milli)seconds before and after the selection.

(i) Play around the crosshair:

1. Click on Player menu.
2. Go to Play around crosshair. The following menu appears:

3. Choose how many (milli)seconds should be played before and after the crosshair. Click on the chosen time interval. The playback will start immediately.
(ii) Play around the selection:

1. Click on Selection menu.

2. Go to Play around selection. The following menu appears:

3. Choose how many (milli)seconds should be played before and after the selection. Click on the chosen time interval. The playback will start immediately.

3.4.4 Playing in slow motion

To change the playback rate, use the slider to the left of the ELAN window. The following options are available:

- Click somewhere above or below the slider to increase or decrease the playback rate by 1%.

- Move the slider up or down to increase or decrease the playback rate.

- Enter the desired playback rate in the box at the bottom of the slider and press the key ENTER. ELAN accepts rates between 5% and 200%.

! Note: Once you have selected a playback rate, the document will be played at the selected rate. If you want it to be played at a different rate, you have to manually change the playback rate, repeating the steps above.

! Note: On slower machines, the slow motion playback may not work properly.
4 Annotations

You can use the ELAN program for annotating your data. This annotation process involves three steps: defining tiers and linguistic types (see sections 4.2 and 4.3), selecting time intervals (see section 4.4), and entering annotations (see section 4.5).

4.1 Basic Information: Annotations, tiers and linguistic types

The following illustration shows an example of an annotation document:

Each annotation is entered on a tier and assigned to a time interval (either directly or to the time interval of another annotation).

All tiers are displayed in the Timeline and Interlinear Viewer, but any one tier can be displayed additionally in theSubtitle Viewer – the so-called ‘active tier’. It is useful to turn the tier you are currently working on into the active tier because (a) the Subtitle Viewer is bigger and supports line wrapping (which makes it easier to read along during playback) and (b) the menu item File / New annotation here is only available for the active tier (see section 3.2.6).

A tier is a set of annotations that share the same characteristics, e.g., one tier containing the orthographic transcription of the speaker's utterances, and another tier containing the free translation of these utterances.
The following two types of tiers exist:

- Independent tiers, which contain annotations that are linked directly to a time interval, i.e., they are “time-alignable”.
- Referring tiers, which contain annotations that are linked to annotations on another tier (i.e., to annotations on their so-called “parent tier”). They are usually not linked directly to the time axis. (Some of them may be linked – but only within the time interval determined by their independent parent tier, see below.)

One example: a transcription tier could be independent and time-alignable, as it is linked directly to the time intervals of the speaker’s utterances. A translation tier, by contrast, would be referring and not time-alignable: it refers to the transcription tier – not directly to the time axis. By definition, it inherits its time alignment from the transcription tier, i.e., from its parent tier.

In the Timeline and Interlinear Viewers, the label of a referring tier is assigned the same color as the label of its independent parent tier. (Different from earlier versions of ELAN, these colors will be maintained – i.e., they will not change if you alter the order of tiers.) The label of the independent parent tier is printed in boldface.

! Note: It is possible to build up nested hierarchies, i.e., tier A can be the parent tier of tier B, and tier B can be the parent tier of tier C, etc.

For example:

<table>
<thead>
<tr>
<th>tier</th>
<th>type</th>
<th>hierarchical relation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ref</td>
<td>independent</td>
<td>parent of tx and ft</td>
</tr>
<tr>
<td>tx</td>
<td>referring</td>
<td>parent of mb</td>
</tr>
<tr>
<td>mb</td>
<td>referring</td>
<td>parent of gl and ps</td>
</tr>
<tr>
<td>gl, ps</td>
<td>referring</td>
<td>–</td>
</tr>
</tbody>
</table>

! Note: Parent and child tiers are linked in such a way that some changes made on a parent tier will also affect its child tiers (but not vice versa):

- If you delete a parent tier, all its child tiers are automatically deleted as well. Similarly, when you delete an annotation on a parent tier, all corresponding annotations on its child tiers are deleted as well.
- If you change the time interval of an annotation on a parent tier, the time interval of the corresponding annotation on all its child tiers are changed accordingly. The time interval of a child tier cannot be changed independently.

! Note: You can view the existing dependency relations by clicking on Options menu, and then on Show Tier Dependencies.
Each tier is assigned to a linguistic type. Each linguistic type specifies a number of constraints that hold for all tiers assigned to that type. Such constraints are bundled into so-called ‘stereotypes’. The following four stereotypes are currently available:

- **None**
  The annotation on the tier is linked directly to the time axis, i.e., the annotation is entered on an independent tier.

- **Time Subdivision:**
  The annotation on the parent tier can be subdivided into smaller units, which, in turn, can be linked to time intervals. Note that there are no time gaps allowed, i.e., the smaller units have to immediately follow each other.

  E.g., an utterance transcribed on a parent tier can be sub-divided into words – each of which is then linked to its corresponding time interval.

  ! Note: Annotations on such tiers are time-alignable. They differ from annotations on independent tiers in that they are assigned to an interval that is contained within the interval of their parent annotation.

- **Symbolic Subdivision:**
  Similar to Time Subdivision, except that the smaller units cannot be linked to a time interval.

  E.g., a word on a parent tier can be sub-divided into individual morphemes (which are not linked to a time interval).

- **Symbolic Association:**
  The annotation on the parent tier cannot be sub-divided further, i.e., there is a one-to-one correspondence between the parent annotation and its referring annotation.

  E.g., one sentence on a parent tier has exactly one free translation. Or one word has exactly one gloss.
The following example illustrates the four different stereotypes:

You can define an unlimited number of tiers. It is useful to make decisions about the type of information that you want to enter (and consequently about the type of tiers that you need) at a relatively early stage in the annotation process. However, it is always possible at a later stage to add new tiers or to change the attributes of already existing tiers.

! Note: Be careful when you change attributes at a later stage. Since the data will be forced into new constraints, data may be lost (see section 4.2.3). In any case, it is a good idea to make a backup copy before you change tier attributes.

! Note: In this version of ELAN, you have to define tiers separately for each individual annotation file (*.eaf).
4.2 How to define a tier and its attributes
ELAN supports the following options:
- adding a new tier (sections 4.2.1 and 4.2.3);
- changing the tier attributes (sections 4.2.2 and 4.2.3);
- deleting a tier (section 4.2.4).

4.2.1 Adding new tiers
Do the following to add a new tier:
1. Click on Edit menu.
2. Click on Add tier. The Add tier dialog window appears.
3. Define the tier attributes (see section 4.2.3).
4. Click OK to save the tier and its attributes. Otherwise click Cancel to exit the window without saving.

Note: It is not yet possible to add tiers to imported documents (from Shoebox or Word Annotation Converter, see sections 2.2.6 and 2.2.8).

4.2.2 Changing tier attributes
Do one of the following to change the attributes of an already existing tier:
(a) Use the mouse.
1. In the Timeline Viewer, right-click at about the height of the tier that you want to change. A pull-down menu appears.
2. In the pull-down menu, click on Change tier attributes. The Change tier attributes dialog window for that tier appears.
3. Change the tier attributes (see section 4.2.3).
4. Click OK to save the changes. Otherwise click Cancel to exit the window without saving.

(b) Use the Edit menu.
1. Click on Edit menu.
2. Go to Change tier attributes. The labels of all available tiers are displayed, e.g.:

3. Click on the tier that you want to change. The Change tier attributes dialog window for that tier appears.

4. Change the tier attributes (see section 4.2.3).

5. Click OK to save the changes. Otherwise click Cancel to exit the window without saving.

4.2.3 Creating/changing tier attributes

Both the Add tier and the Change tier attributes submenus allow you to edit tier attributes. Both options lead to the following dialog window:

Enter the following information:

(1) Go to Tier name. Enter/change the tier name.

The tier name is the name that is displayed in the Timeline, Interlinear and Subtitle Viewer.
! Note: Names may not be the same as commands used in the ELAN menu. E.g., if you choose to call a tier ‘Quit’, the following error message will appear:

(2) Go to Participant. Enter/change the name of the participant whose utterance is being transcribed.

(3) Go to Linguistic type. Select/change a linguistic type from the predefined list in the pull-down menu (see section 4.3).

(4) Go to Parent tier. Select/change a parent tier from the pull-down menu.

• If the tier has no parent tier, select none.
• Otherwise select the appropriate parent tier.

! Note: If the tier is associated with the stereotype “none” (see section 4.3), only the option none will be available.

! Note: It is possible to change the dependency relations between tiers later on, but this process may lead to the loss of data. If you decide to assign a tier to a different parent tier, ELAN will automatically align its annotations with that of the new parent tier (based on overlapping time intervals). In this case, if there is an annotation on the referring tier, but no overlapping annotation on the parent tier, ELAN will delete this annotation. Be very careful that you do not lose such annotations accidentally. In any case, it is a good idea to make a backup copy before you change tier attributes. A referring tier can be turned into an independent time-alignable tier without any problem.

(5) Go to Default Language. Select/change the default character set from the pull-down menu.

Whenever you enter or change annotations on that tier, the text entry box is automatically preconfigured for the default character set.

Click OK to save the settings/changes. Otherwise click Cancel to exit the window without saving.
4.2.4 Deleting tiers

Do one of the following to delete a tier:

(a) Use the mouse.
1. In the Timeline Viewer, right-click at about the height of the tier that you want to delete. A pull-down menu appears.
2. In the pull-down menu, click on Delete tier.
3. A warning dialog appears asking you to confirm the deletion (see below).

(b) Use the Edit menu.
1. Click on Edit menu.
2. Go to Delete tier. The labels of all available tiers are displayed, e.g.:
3. Click on the tier that you want to delete. A warning dialog appears asking you to confirm the deletion., e.g.:
4. Click Yes to delete the tier and all its child tiers; click No to not delete them.

! Note: When you delete a tier, you will lose all its annotations.
! Note: If you delete a parent tier, all its child tiers will be automatically deleted as well. Please make sure that you do not accidentally delete a child tier.

To delete a parent tier without deleting its child tiers, you have to change the attributes of the child tier. Do the following for each child tier:

1. Click on Edit menu.
2. Go to Change tier attributes. The labels of all available tiers are displayed.
3. Click on the tier that you want to remove from the list of child tiers. The Change tier attributes dialog window appears.
4. Go to Parent tier.
5. In the pull-down menu, select none.
6. Click OK to save the changes.

You can now delete the former parent tier without deleting its former child tier.

A child tier can be deleted without any consequences for its parent tier.
4.3 How to define a linguistic type

ELAN supports the following options:

- adding a new linguistic type (sections 4.3.1 and 4.3.3);
- changing the attributes of a linguistic type (sections 4.3.2 and 4.3.3);
- deleting a linguistic type (section 4.3.4).

4.3.1 Adding new linguistic types

Do the following to add a new linguistic type:

1. Click on Edit menu.
2. Click on Add linguistic type. The Add type dialog window appears.
3. Define the linguistic type (see section 4.3.3).
4. Click OK to save the linguistic type. Otherwise click Cancel to exit the window without saving.

4.3.2 Changing linguistic types

Do the following to change the attributes of an already existing linguistic type:

1. Click on Edit menu.
2. Go to Change linguistic type. The labels of all available linguistic types are displayed, e.g.:

   ![Edit menu](image)

   ![Change linguistic type submenu](image)

   ![available linguistic types](image)

3. Click on the linguistic type whose attributes you want to change. The Change type dialog window appears.
4. Change the linguistic type (see section 4.3.3).
5. Click OK to save the changes. Otherwise click Cancel to exit the window without saving the changes.
4.3.3 Creating/changing linguistic types

Every tier is assigned to a linguistic type. The linguistic type specifies the stereotypical constraints (and, as a consequence, whether or not the tiers are time-alignable).

! Note: Information about the relationship between tiers is given in two different places: for each individual tier it is given in the Add tier attributes dialog window (see section 4.2.3), and for all tiers belonging to one linguistic type it is given in the Add type window (this section), i.e.:

- **Add tier attributes** window: specify the parent tier of the individual tier.
- **Add type** window: specify the stereotypical constraints of tiers belonging to one type.

To create/change a linguistic type, do the following:

1. Click on **Edit** menu.

2. Either go to **Add linguistic type** or to **Change linguistic type**. In the latter case, click on the linguistic type that you want to change. The **Add/Change type** dialog window appears:

```plaintext
enter a label for the new type
```

```plaintext
select the stereotypical constraint:
```

Enter the following information:

(1) Go to **Linguistic type**. Enter/change the name for the type.

! Note: Names may not be the same as commands used in the ELAN menu. E.g., if you choose to call a linguistic type ‘Quit’, the following error message will appear:
(2) Go to Stereotype. Select the stereotypical constraint relevant to its tiers (see section 4.1).

! Note: After you have selected a stereotypical constraint, ELAN automatically enters the correct value next to the box Time-alignable.

Click OK to save the settings; otherwise click Cancel to exit the window without saving.

4.3.4 Deleting linguistic types
To delete a linguistic type, do the following:
1. Click on Edit menu.
2. Go to Delete linguistic type. The names of all available linguistic types are displayed, e.g.:

3. Click on the type you want to delete. A warning appears, e.g.:

4. Click Yes to delete the type; otherwise click No.

! Note: You can only delete a linguistic type if it is not used by any of the tiers. If it is used, the following error message appears:
4.4 **How to make a selection**

In order to make an annotation, you first have to select a time interval. ELAN supports the following options:

- making and saving a selection on an independent tier (section 4.4.1);
- making and saving a selection on an independent tier while playing (section 4.4.2);
- making and saving a selection on a referring tier (section 4.4.3);
- deselecting a selection (section 4.4.4);
- changing the time alignment of an existing selection (section 4.4.5);
- activating and deactivating the Bulldozer mode (section 4.4.6).

### 4.4.1 Making and saving a selection on an independent tier

To make a selection, do the following:

1. Go either to the Waveform or the Timeline Viewer.
2. Go with the mouse to the beginning of the time interval you want to select.
3. Click the mouse button, keep it clicked and drag it to the endpoint of the time interval you want to select.

The video image will be continuously updated. The selected part is highlighted in light blue color.

The selection can be extended beyond the size of the current window. The display in all Viewers will automatically move along.

! Note: If you click on the time axis that is displayed to the top and bottom of the Waveform and Timeline Viewers (i.e., the line that displays timecode information), the crosshair will not respond. Click somewhere within the Viewers.
You can change the beginning and endpoints of the selection. Do one of the following:

(a) Either use the mouse: press the key Shift, keep it pressed and click with the mouse to the left/right of the selected part. The selection will be extended to include this point.

(b) Or use the following shortcut keys to move the selection stepwise to the left/right:

CTRL+B: to move the beginning of the selection to the left.
CTRL+ALT+B: to move the beginning of the selection to the right.
CTRL+E: to move the end of the selection to the left.
CTRL+ALT+E: to move the end of the selection to the right.
The stepsize is determined by the step mode (see section 3.3.3).

! Note: It is currently not possible to make a selection that is shorter than 80 milliseconds.

You can save the selection. Do the following:

1. Access the Inline Edit box by doing one of the following:

(a) Either double-click in the Timeline Viewer on the selection at about the height of the tier where you want to enter the annotation.

(b) Or click on Edit menu, then click on New annotation here (active tier only).

(c) Or use the key equivalent CTRL+N (active tier only).

In all cases, the Inline Edit box appears, e.g.:

![Image of Inline Edit box example]
2. Do one of the following:
   (a) Enter an annotation (see section 4.5), and then press the keys CTRL+ENTER to save the selection. Otherwise press the key ESC.
   (b) Press the keys CTRL+ENTER (without entering an annotation) to save the selection. Otherwise press the key ESC.

   ! Note: Only selections on time-alignable tiers can be saved in this way. To save a selection on a referring tier, see section 4.4.3.

4.4.2 Making and saving a selection on an independent tier while playing

It is possible to start a new selection immediately after a previous selection has ended, i.e., the endpoint of one selection will be taken as the starting point for the next selection. Do the following:

1. Make a selection on an independent tier (see section 4.4.1).
2. Double-click on the selection.
3. Press the keys CTRL+ENTER. The selection is saved. (Do not enter any annotation yet.)

4. Press the key Esc to deselect the selection (see section 4.4.4 for deselecting a selection).
5. Do one of the following:
   
   (a) Press the key SHIFT, keep it pressed and play the document (see section 3.4.1 for playing a document). Release the SHIFT key where you want your next selection to end.
   
   (b) Play the document (see section 3.4.1 for playing a document). Press the key SHIFT where you want your next selection to end.
   
   The playback stops. The new selection extends from the endpoint of the previous selection until the point when the playback was stopped.
   
   Repeat steps 2 and 3 to save the new selection.
   
   Repeat steps 3 to 5 to add another selection.
   
4.4.3 Making and saving a selection on a referring tier

A referring tier inherits all its time alignments from its parent tier. To make and save a selection on a referring tier, do the following:

1. Select and save a time interval on the corresponding parent tier (see sections 4.4.1 and 4.4.2).

2. Double-click somewhere within the time interval of the parent annotation at about the height of the referring tier. If the referring tier is assigned to the “time subdivision” constraint, select some pixels first, and then double-click on them. The Inline Edit box appears.
3. Do one of the following:
   (a) Enter an annotation (see section 4.5), and then press the keys CTRL+ENTER to save the selection. Otherwise press the key ESC.
   (b) Press the keys CTRL+ENTER (without entering an annotation) to save the selection. Otherwise press the key ESC.

4.4.4 Deselecting a selection
To deselect a selection, do one of the following:
(a) Either use the menu options:
   1. Click on Selection menu.
   2. Click on Deselect.
(b) Or use the shortcut key ESC.

! Note: Whenever you select another time interval, the old selection is automatically deselected.

4.4.5 Changing the time alignment of an existing selection
To change the time alignment of an existing selection, do the following.
1. In the Timeline Viewer, click on the annotation to be edited. The annotation is highlighted in a dark blue frame, and the corresponding selected time interval is highlighted in light blue color.
2. Modify the beginning/endpoints of the selection:
   (a) Either use the mouse: press the key Shift, keep it pressed and click with the mouse to the left/right of the selected part. The selection will be extended to include this point.
   (b) Or use the following shortcut keys to move the selection stepwise to the left/right:
      CTRL+B: to move the beginning of the selection to the left.
      CTRL+ALT+B: to move the beginning of the selection to the right.
      CTRL+E: to move the end of the selection to the left.
      CTRL+ALT+E: to move the end of the selection to the right.
The stepsize is determined by the step mode (see section 3.3.3).

3. Press the keys CTRL+ENTER to update the selection.

Note: It is currently not possible to make a selection that is shorter than 80 milliseconds.

Note: Only the time-alignment of annotations on the following types of tiers can be modified: annotations on independent tiers, and annotations on referring tiers that fall under the Time Subdivision stereotype (but note that in the latter case, the alignment cannot be extended beyond the boundaries of its parent annotation, see section 4.1). To modify the time alignment of annotations on all other tiers, change the time alignment on the corresponding parent tier (following the steps above). The time alignment on all referring tiers is automatically updated.
4.4.6 Activating and deactivating the Bulldozer mode

ELAN supports two modes: the Overwrite mode and the Move or Bulldozer mode. These two modes are comparable to the Overwrite and Insert modes that are supported by many text editor programs such as, e.g., Microsoft Word.

- **Overwrite mode:** if you extend a selection into a time interval that is already occupied by a previously saved selection (i.e., an annotation), that annotation is (partly or wholly) overwritten.

- **Move or Bulldozer mode:** if you extend a selection into a time interval that is already occupied by a previously saved selection (i.e., an annotation), that annotation is moved to the right/left.

The following conventions apply for the Bulldozer mode:

- Annotations are moved to the right if you extend your selection from left to right. They are moved to the left if you extend your selection from right to left.

- If a moved annotation extends into the time-interval of yet another annotation, that other annotation is moved accordingly. If it extends into empty space, no other annotations are affected.

! Note: Moving annotations may thus affect the whole document, and may thereby destroy previous time alignments. Please make sure that the Bulldozer Mode is not accidentally switched on.
The Overwrite mode is the default mode.

To switch to the Bulldozer mode, do the following:

1. Click on Option menu.
2. Click on Bulldozer Mode. A checkmark appears next to it, and the label Bulldozer Mode appears in the header of the ELAN window.

To switch back to the Overwrite mode, repeat steps 1 and 2 above. The checkmark disappears and the label Bulldozer Mode is removed from the header of the ELAN window.
4.5 How to enter annotations

All annotations are entered either into the Inline Edit box or into the Edit Annotation box, which are accessed via the Timeline, Interlinear and Grid Viewers. ELAN supports the following options:

- entering annotations (sections 4.5.1 and 4.5.2);
- entering annotations before/after other annotations (section 4.5.3);
- modifying the content of annotations (section 4.5.4);
- deleting annotations (section 4.5.5);
- entering annotations in different character sets (section 4.5.6).

4.5.1 Entering annotations (into the Inline Edit box)

To enter an annotation into the Inline Edit box, do the following:

1. Access the Inline Edit box by doing one of the following:
   
   (a) Either make a selection in the Timeline Viewer (see section 4.4.1), and then do one of the following:
       - double-click on the selection at about the height of the tier where you want to enter the annotation;
       - click on Edit menu, then click on New annotation here (active tier only);
       - or use the key equivalent CTRL+N (active tier only).
   
   (b) Or click on an existing annotation in the Timeline, Interlinear or Grid Viewer to select it, and then double-click on it.

In all cases, the Inline Edit box appears, e.g.:
2. Click into the **Inline Edit** box.

3. Enter the annotation.

   It is possible to enter text that contains line breaks. The text entry box automatically displays a scrollbar if necessary.

   The **Inline Edit** box is automatically preconfigured for the default character set of the tier (see section 4.2.3). If you want to use a different character set, do the following:

   1. Right-click in the **Inline Edit** box. A pull-down menu appears that displays the available character sets.

   2. Click on the appropriate character set. From now on, the characters are entered in the selected set.

   3. To switch back to the default character set, repeat the steps above and select the default set from the pull-down menu.

4. Save the annotation by doing one of the following:
   
   (a) Use the shortcut keys **CTRL+ENTER**.

   (b) Or right-click in the **Inline Edit** box and click on **Commit Changes** in the pull-down menu.

To exit the **Inline Edit** box without saving, do one of the following:

(a) Use the shortcut key **Esc**.

(b) Or right-click in the **Inline Edit** box and click on **Cancel Changes** in the pull-down menu.
4.5.2 Entering annotations (into the Edit Annotation box)

The Edit Annotation box differs from the Inline Edit box in that it has a bigger display and supports line wrapping. It is therefore better for entering longer texts.

To enter an annotation into the Edit Annotation box, do the following:

1. Either make a selection in the Timeline Viewer (see section 4.4.1), or click on an existing annotation in the Timeline or Interlinear Viewer.

2. Access the Inline Edit box (see section 4.5.1).

3. Do one of the following:
   (a) Either use the shortcut keys `SHIFT+ENTER`.
   (b) Or right-click in the Inline Edit box. A pull-down menu appears. Click on Detach Editor.

4. The Edit Annotation box appears:

The Edit Annotation box is automatically preconfigured for the default character set of the tier (see section 4.2.3). If you want to use a different character set, do the following:

1. Click on Select Language. A pull-down menu appears that displays the available character sets, e.g.:

2. Click on the appropriate character set. From now on, the characters are entered in the selected set.
3. To switch back to the default character set, repeat the steps above and select the default set from the pull-down menu.

5. Save the annotation by doing one of the following:
   (a) Use the shortcut keys CTRL+ENTER.
   (b) In the Edit Annotation box, click on Edit and then click on Commit Changes in the pull-down menu.

To exit the Edit Annotation box without saving, do one of the following:
   (a) Use the shortcut key Esc.
   (b) In the Edit Annotation box, click on Edit and then click on Cancel Changes in the pull-down menu.

To return to the Inline Edit box, do one of the following:
   (a) Use the shortcut keys SHIFT+ENTER.
   (b) In the Edit Annotation box, click on Attach Editor in the pull-down menu.

4.5.3 Entering annotations before/after other annotations
Annotations on some tiers can be subdivided into smaller units. In this way, you can for example break up a word into its different morphemes, as in the following illustration:

Note: This option is only available for those tiers that are assigned to the stereotypes Time Subdivision and Symbolic Subdivision (see section 4.1).
To divide an annotation into smaller units, do the following:

1. In the Timeline or Interlinear Viewer, click on the annotation that you want to subdivide. It appears in a dark blue frame.

2. Do one of the following:
   
   (a) Right-click on the selected annotation. A pull-down menu appears. Click on either **New Annotation before** or on **New Annotation after** to subdivide the annotation.

   (b) Or click on **Edit** menu. Then click on either **New Annotation before** or on **New Annotation after** to subdivide the annotation.

   If you click on **New annotation before**, the original annotation is divided and the new annotation is inserted to its left (as in the illustration below). If you click on **New annotation after**, it is inserted to its right.

   ![Diagram of annotation subdivision](image)

   ! Note: An annotation is always subdivided into two units. If you need further subdivisions, repeat the steps above.
4.5.4 Modifying the content of annotations

To modify an annotation, do one of the following:

(a) In the Timeline or Interlinear Viewer:
1. Click on the annotation that you want to modify. It appears in a dark blue frame.
2. Do one of the following:
   (a) Right-click on the selected annotation. A pull-down menu appears. Click on Modify annotation value.
   (b) Or click on Edit menu. Click on Modify annotation value.
   (c) Or use the key equivalent CTRL+M.
   The Inline Edit box appears (see section 4.5.1).

(b) In the Grid Viewer:
1. Double-click on the annotation that you want to modify.
   The Inline Edit box appears (see section 4.5.1).

4.5.5 Deleting annotations

To delete an annotation, do the following:

1. In the Timeline or Interlinear Viewer, click on the annotation that you want to delete. It appears in a dark blue frame.
2. To delete it, do one of the following:
   (a) Right-click on the selected annotation. A pull-down menu appears. Click on Delete annotation.
   (b) Or click on Edit menu. Then click on Delete annotation.
   (c) Or use the key equivalent CTRL+D.

! Note: The annotation is deleted without further warning.

! Note: If you delete an annotation on a parent tier, the corresponding annotations on all its child tiers will be automatically deleted as well. Please make sure that you do not accidentally delete a child annotation. An annotation on a child tier can be deleted without consequences for the annotation on its parent tier.

! Note: There is no ‘undo’ option yet.
4.5.6 Entering annotations in different character sets

ELAN supports different character sets, making use of the following input methods:

(a) GATE Unicode Kit (GUK)

Characters can be entered by using a different keyboard mapping. This method is implemented using the GATE Unicode Kit developed at Sheffield University, Department of Computer Science.

If you select a character set that is based on GUK, a visual representation of a keyboard appears on the screen, which informs you about the implemented keyboard mapping. The following illustrations show the mappings of “ipa-96 (SAMPA)” and “Arabic (WINDOWS)”:

![ipa-96 (SAMPA) keyboard map](image)
![Arabic (WINDOWS) keyboard map](image)

To enter a character, do one the following:

(a) Either press the corresponding key on your keyboard.
(b) Or click on the corresponding key of the keyboard displayed on your screen.

Note: The visual representation has the layout of the standard UK keyboard. If you do not have a UK keyboard, there may be mismatches between the characters and their visual representation.

For example, the IPA character “œ” is matched to the key “@”, i.e., in order to get “œ”, you have to type “@”. On a standard UK keyboard, the key “@” is located to the left of the key “enter” (see the illustration above). On other keyboards, however, “@” may be located on a different key. In such cases, if you press the key to the left of “enter”, you will not get the character “œ”. To get “œ”, you have to search for the location of “@” on your keyboard, and then
press that key. (Note that these mismatches only arise if you use the physical keyboard, but not if you use the visual representation on the screen.)

! Note: The character set “ipa-96 (SAMPA)” can be used to enter IPA characters. However, the current version of ELAN only supports SAMPA, but not X-SAMPA. As a consequence, some of the characters that you require may not be available yet (see http://www.phon.ucl.ac.uk/home/sampa for further information).

(b) Roman Typographic Root (RTR)

IPA characters can be entered using the RTR input method. This method is based on the following principle: whenever you type a character, all typographically similar characters are displayed in a lookup list, as shown in the following illustration:

To select a character from the lookup list, do the following:
1. Use the Up and Down arrow keys to navigate to the desired character.
2. Press ENTER or SPACE to confirm the selection.

! Note: Do not use the mouse within the lookup window. If you do, the window will disappear.

! Note: The input of IPA characters is restricted to the official IPA-96 character set. Withdrawn or superseded characters are not supported.

! Note: The RTR-mapping is generally obvious, but please pay attention to the following features:

• Use lower case letters only.
• IPA characters can map to non-letter symbols, e.g.:

! Note: On Windows 2000, if you use an international keyboard, you have to type SPACE after typing the quotation mark (‘) or one of the accents (’, `, ^).

! Note: It is possible to stack diacritics, but there may be problems displaying them.
(c) **Chinese characters**

Chinese characters, both traditional and simplified, are entered using the Pinyin method. Characters are selected by starting to type Roman characters. Candidates are shown in a lookup window while the user types along. The desired character is selected with the Up and Down arrow keys, e.g.:

Use the following procedure:

- Enter the pinyin word with the keyboard. For each pinyin word, a list of Han symbols is shown in a popup window.
- Navigate to a Han symbol with the UP and DOWN arrow keys.
- Page through the list with the PAGE UP and PAGE DOWN keys.
- Select a Han symbol with the SPACE or the ENTER key.

! Note: Do not use the mouse within the lookup window. If you do, the window will disappear.

! Note: On Windows 98, you cannot display both Chinese and IPA characters.
5 Search options

The ELAN tool allows you to search annotations within one document (see section 5.1.1), to display the results (see section 5.1.2) and to jump to the corresponding annotation in the ELAN window (see section 5.1.3).

5.1 How to search annotations

5.1.1 Searching

To search for text, do the following:

1. Click on Search menu.

2. Go to Search…. The following dialog window is displayed:
3. The following search options are available:

   (1) Go to Annotation on tier and, from the pull-down menu, select the tier to be searched.

   (2) Go to matches and type in the item to be searched.

   ! Note: You can always make use of regular expressions to conduct your searches (see APPENDIX: REGULAR EXPRESSION SEARCH for the regular expression syntax).

   (3) Click on Add new constraint to add a second (or third) tier and search item.

   In this case, you can specify the number of annotations that can intervene between the first search item and the second search item (or between the second and third item). In the Search-Dialog box, the following terminology applies:

   • One “utterance” corresponds to an annotation on an independent, time-alignable tier.
   • One “word” corresponds to an annotation on a referring tier assigned to the “time subdivision” constraint.
   • One “annotation” corresponds to an annotation of the tier specified in the first constraint.

   For example:

<table>
<thead>
<tr>
<th>tier</th>
<th>annotations</th>
<th>utterance</th>
<th>words</th>
</tr>
</thead>
<tbody>
<tr>
<td>st (sentence)</td>
<td>He sees trees and flowers.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tx (word)</td>
<td>he sees trees and flowers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>mb (morpheme break)</td>
<td>see -s tree -s</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ps (part of speech)</td>
<td>V SUF N SUF</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
It is possible to search on different tiers within one annotation. For example, the search parameters illustrated below search for all annotations on the tier tx, which contain “-s” in one of their morpheme breaks and “N” in one of their parts of speech. (Both “-s” and “N” are in distance of “0 words”, i.e., they occur within the same word as specified on the tier tx.) I.e., these parameters would find “trees” and “flowers” in the above example, but not “sees”.

It is also possible to search for sequences of utterances, words or other annotations on the same tier, e.g.:

on the tier tx, the annotation “flowers” follows 1 to 3 annotations after the annotation “trees”

You can delete the second (or third) search item. Click on Delete last constraint to delete it.
(4) Click on View dependencies to view the dependency relations between tiers.

(5) Go to Select language to change the input character set from the pull-down menu.

You only need this option if you want to select a non-default character set. The box automatically displays the default set of the selected tier (see section 4.2.3).

If you search for two (or three) items (by making use of the option Add new constraint), the Select language box displays the language corresponding to the currently active constraint. Make the constraint active by clicking in the box to the right of matches.

4. After you have specified your search parameters, click Search to start the search process.

5.1.2 Displaying search results

After the Search is completed, ELAN displays the following search results:

- The number of annotations where the search item was found.
- The full content of each annotation where the search item was found.
- The beginning and end time of each annotation where the search item was found.

! Note: In this version of ELAN it is not yet possible to save search results or to print them. You can only see them on your screen.

5.1.3 Jumping from the search results to annotations

You can jump from the annotations displayed in the Search-Dialog window to the corresponding annotations in the ELAN window. This option allows you to access other types of information that are linked to the annotations found: to listen to the
audio, to watch the video, to view the waveform or to read the annotations on different tiers.

Do the following: In the **Search-Dialog** window, click on the annotation that you want to jump to. It will be highlighted in blue color. In the **ELAN** window, the corresponding annotation is automatically accessed.

The screen display should look similar to the following illustration:
PART III: REFERENCE GUIDE

In this reference guide, you find concise descriptions of the mouse options (1), the menu item (2), and the shortcut keys (3). In addition, a brief definition of key concepts is provided (4), and the new features of version 1.4 (compared to earlier versions) are listed (5).

1. The Mouse Options

Resizing Viewers
- Click on the up/down arrows in the split-pane to increase/decrease the size of the corresponding Viewer.
- Go with the mouse to the split-pane and move it up/down to increase/decrease the size of the corresponding Viewer.

Rearranging the order of tiers
- Drag a tier label from its place in the Timeline or Interlinear Viewer to any other place in the Timeline Viewer.

Make a tier the active tier
- Click on a tier label.
- Drag a tier label from its place in the Timeline or Interlinear Viewer to the Subtitle Viewer.

Accessing points in time
- Click on any place in the Timeline or Waveform Viewer to jump to this point in time.
- Click on the right/left of the Timeline Viewer scrollbar to go forward/backward in time.
- Click on the timecode box and enter a timecode to jump to this point in time.

Playing a document
- Click on the Play/Pause icon to start or pause the playback.
- Use the slider to increase/decrease the playback rate.

Making a selection
- Click with the mouse on any point in the Timeline or Waveform Viewer, and drag it to another point to select a time interval. Or click on an annotation in the Grid Viewer and drag the mouse to another annotation.
- Click on an annotation in the Timeline or Interlinear Viewer to select it.
Adding/modifying an annotation

- Double-click on an annotation or selection (at about the height of the tier where you want to enter an annotation). The Inline Edit box appears and you can enter the annotation.

2. The Menu Items

Note: The starred options (*) are also available whenever you right-click somewhere within the Timeline or Interlinear Viewer (at about the height of the relevant tier).

File menu

- **New**: Creates a new annotation file (*.eaf) for an existing media file (*.wav, *.mpg/*.mov).
- **Open**: Opens an existing annotation file (*.eaf).
- **Close**: Closes the current ELAN document.
- **Save**: Saves changes to the annotation file (*.eaf).
- **Automatic backup**: Creates an automatic backup copy.
- **Import Shoebox file**: Imports a Shoebox file (*.txt).
- **Export as Shoebox file**: Exports the document as a Shoebox file (*.txt).
- **Import Word Annotation Converter file**: Imports a WAC (Word Annotation Converter) file (*.wac.txt).
- **Export as tab-delimited text**: Exports the document as a tab-delimited text file (*.txt).
- **Quit**: Quits the ELAN window.

Edit menu

- **(*) New annotation here**: Creates a new annotation on the active tier. The option is only available if a time interval or an annotation is selected.
- **(*) New annotation before**: Subdivides an existing annotation (and adds the new part to the left of the old annotation). The option is only available if an annotation is selected and if the corresponding tier is assigned to either the stereotype Time Subdivision or Symbolic Subdivision.
- **(*) New annotation after**: Subdivides an existing annotation (and adds the new part to the right of the old annotation). The option is only available if an annotation is selected and if the corresponding tier is assigned to either the stereotype Time Subdivision or Symbolic Subdivision.
- **(*) Modify annotation value**: Modifies the content of an annotation. The option is only available if an annotation is selected.
- **(*) Delete annotation**: Deletes an existing annotation. The option is only available if an annotation is selected.
• Add tier: Displays a dialog window that allows you to add a new tier.
• (*) Change tier attributes: Changes the attributes of an existing tier.
• (*) Delete tier: Deletes an existing tier.
• Add linguistic type: Displays a dialog window that allows you to add a new linguistic type.
• Change linguistic type: Changes the attributes of an existing linguistic type.
• Delete linguistic type: Deletes an existing linguistic type.

Search menu
• Search …: Allows you to search for text within an ELAN document.

View menu
• Video: Allows you to switch the Video Viewer on/off. The option is only available if a corresponding video file (*.mpg/*.mov) exists.
• Waveform: Allows you to switch the Waveform Viewer on/off. The option is only available if a corresponding audio file (*.wav) exists.
• Subtitle Viewer: Allows you to switch the Subtitle Viewer on/off.
• (*) Grid Viewer: Allows you to switch the Grid Viewer on/off.
• Timeline Viewer: Allows you to switch the Timeline Viewer on/off. While the Timeline Viewer is switched on, the Interlinear Viewer is switched off.
• Interlinear Viewer: Allows you to switch the Interlinear Viewer on/off. While the Interlinear Viewer is switched on, the Timeline Viewer is switched off.
• None: Allows you to switch both the Timeline Viewer and the Interlinear Viewer off.
• Visible Tiers: Allows you to switch on/off individual tiers in the Timeline and Interlinear Viewers.
• Resolution: Allows you to change the resolution of the Waveform and the Timeline Viewer.
• Font size: Allows you to change the font size throughout the document.

Player menu
• Play/Pause: Starts/pauses the playback of the file.
• Forward: Moves the crosshair one step forward.
• Rewind: Moves the crosshair one step backward.
• Play around crosshair: Plays a few (milli-)seconds before and after the crosshair.
### Selection menu
- **Step mode**: Sets the step size for moving through the file.
- **Go to selection**: Moves the crosshair from any place in the file to the beginning of the current selection.
- **Deselect**: Deselects the current selection.
- **Play selection**: Plays the current selection.
- **Play around selection**: Plays a few (milli-)seconds before and after the current selection.

### Options menu
- **Show Tier Dependencies**: Shows the hierarchical relations between tiers.
- **Bulldozer mode**: (De)activates the Bulldozer mode.

### Help menu
- **Display shortcuts**: Displays a list of shortcut keys.
- **About EUDICO Linguistic Annotator**: Displays the version and copyright information.

### 3. The Shortcut Keys

#### File options
- Ctrl+S **S**aves the current project
- Ctrl+Q **Q**uits the session

#### Playing a document
- **CTRL+SPACE** Starts or stops the Media Player (on the PC)
- **CTRL+P** Starts or stops the Media Player (on the Mac)
- **CTRL+F** Forwards the media file by one step
- **CTRL+R** Rewinds the media file by one step
- **CTRL+L** Plays the current selection

#### Working with annotations
- **CTRL+N** Opens the Inline Edit box for inserting a new annotation (only available if a time interval or annotation is selected)
- **CTRL+M** Opens the Inline Edit box for modifying an annotation (only available if an annotation is selected)
- **CTRL+D** Deletes an annotation (only available if an annotation is selected)
- **CTRL+ENTER** Saves the changes made to the Inline Edit box or the Edit annotation box
ESC (from within the Inline Edit box or the Edit annotation box): exits the box without saving the changes
ESC (in all other contexts): deselects a selection
SHIFT+ENTER Allows you to switch between the Inline Edit box and the Edit annotation box

Working with selections
CTRL+B Moves the beginning of the selection to the left
CTRL+ALT+B Moves the beginning of the selection to the right
CTRL+E Moves the end of the selection to the left
CTRL+ALT+E Moves the end of the selection to the right
ESC Deselects the selection

Displaying shortcut keys
CTRL+H Help: displays the list of shortcut keys

4. Key concepts of ELAN

Annotation file (*.eaf)
An annotation file is the document that contains all the information about tiers (their attributes and dependency relations), annotations and time alignments.

Media file (*.mpg/*.mov, *.wav)
A media file contains the digitized video/audio (*.mpg/*.mov) or only the audio (*.wav) data. It determines the time axis to which the annotation file (*.eaf) is linked.

Annotation
An annotation is any type of text (e.g. a transcription, a translation, coding, etc.) that is entered on a tier. It is assigned to a selected time interval of the video/audio file (e.g., to the time interval corresponding to the utterance of a speaker) or to an annotation on another tier (e.g., a translation is assigned to an orthographic transcription).

Tier
A tier is a set of annotations that share the same characteristics, e.g., one tier containing the orthographic transcription, or another tier containing the free translation.

A tier can be ‘independent’ and ‘time-alignable’, in which case it is directly linked to a time interval of the media file (e.g., the ‘orthographic transcription’ tier). Or it can be ‘referring’, in which case it is linked to another tier, its so-called parent tier (e.g., the ‘orthographic transcription’ tier is a parent tier to the ‘free translation’ tier). The referring tier shares its time alignment with its parent tier. Some referring tiers can be assigned to the time axis, but only to an interval that is contained within the interval of their parent annotation.
It is possible to build nested hierarchies, e.g., the ‘orthographic transcription’ tier is the parent tier to a ‘word’ tier, and the ‘word’ tier is the parent tier to a ‘morpheme break’ tier.

Tiers are assigned to linguistic types, which specify certain constraints. The following constraints exist: None (independent, time-alignable tiers), Time Subdivision (the annotation on the referring tier can be subdivided and linked to the time axis), Symbolic Subdivision (the annotation on the referring tier can be subdivided, but not linked to the time axis), Symbolic Association (one annotation on the referring tier corresponds to exactly one annotation on the parent tier).

5. Comparison to earlier versions
The following features were added or changed in version 1.2:

- Exporting a document as a tab-delimited text file (section 2.2.9).
- Importing and exporting between ELAN and Shoebox (sections 2.2.6, 2.2.7).
- The Interlinear Viewer (sections 3.1.5, 3.3.5).
- Color coding to visualize complex hierarchies (section 3.1.8);
- Slider (for playing in slow motion) (section 3.4.4).
- New options for dependency relations between tiers and constraints on tiers (sections 4.1, 4.3).
- Support of two modes: Overwrite and Bulldozer modes (section 4.4.6).
- Entering annotations via the Inline Edit box (section 4.5.1).
- Subdividing annotations, i.e., entering annotations before/after existing annotations (section 4.5.3).
- Modifying annotations from within the Grid Viewer (section 4.5.4).
- Improved search options (chapter 5, APPENDIX: REGULAR EXPRESSION SEARCH).

The following features were added or changed in version 1.3:

It was possible to provide workarounds for some JMF (Java Media Framework) bugs. A number of errors were fixed in this way, and, as a result, the performance of ELAN has improved considerably (for details, see the release notes under http://www.mpi.nl/tools/elan/release-notes.html).

Other changes:

- Imported files (Shoebox, Word Annotation Converter) can be saved as ELAN files (*.eaf) (section 2.2.4).
- Creation of automatic backup copies (section 2.2.5).
- Imported SIL IPA characters are converted into Unicode characters (section 2.2.6).
• Import of WAC (Word Annotation Converter) files (section 2.2.8).
• The JMF (Java Media Framework) Media Player has been reduced to a single Play button, a Timecode box, and a Slider (section 3.1.7).
• The active tier can be selected by using the pull-down menu (section 3.2.6).

The following features were added or changed in version 1.4:

ELAN can now work with Quicktime (as an alternative to the Java Media Framework), which also runs on MacOS 10 (for details, see the release notes under http://www.mpi.nl/tools/elan/release-notes.html).

Other changes:
• The active tier can be selected by clicking on it (section 3.2.6).
• A selection can be played from the position of the crosshair (section 3.4.2).
• The color of the tier labels is maintained (section 4.1).
• Make a selection while playing (section 4.4.2).
• Use the shortcut key ESC to deselect a selection (section 4.4.4).
APPENDIX: REGULAR EXPRESSION SEARCH
(package gnu.regexp; Syntax and Usage Notes; last updated on 22 June 2001)

Brief Background
A regular expression consists of a character string where some characters are given special meaning with regard to pattern matching. Regular expressions have been in use from the early days of computing, and provide a powerful and efficient way to parse, interpret and search and replace text within an application.

Supported Syntax
Within a regular expression, the following characters have special meaning:

- **Positional Operators**
  - `^` matches at the beginning of a line\(^2\)
  - `$` matches at the end of a line\(^3\)
  - `\A` matches the start of the entire string
  - `\Z` matches the end of the entire string
  - `\b` matches at a word break (Perl5 syntax only)
  - `\B` matches at a non-word break (opposite of `\b`) (Perl5 syntax only)
  - `\<` matches at the start of a word (egrep syntax only)
  - `\>` matches at the end of a word (egrep syntax only)

- **One-Character Operators**
  - `.` matches any single character\(^4\)
  - `\d` matches any decimal digit
  - `\D` matches any non-digit
  - `\n` matches a newline character
  - `\r` matches a return character
  - `\s` matches any whitespace character
  - `\S` matches any non-whitespace character
  - `\t` matches a horizontal tab character
  - `\w` matches any word (alphanumeric) character
  - `\W` matches any non-word (alphanumeric) character

---
\(^2\) but see the REG_NOTEOL and REG_MULTILINE flags
\(^3\) but see the REG_NOTEOL and REG_MULTILINE flags
\(^4\) but see the REG_MULTILINE flag
\x matches the character x, if x is not one of the above listed escape sequences.

- **Character Class Operator**
  
  [abc] matches any character in the set a, b or c
  
  [^abc] matches any character not in the set a, b or c
  
  [a-z] matches any character in the range a to z, inclusive
  
  A leading or trailing dash will be interpreted literally.

Within a character class expression, the following sequences have special meaning if the syntax bit RE_CHAR_CLASSES is on:

- [:alnum:] Any alphanumeric character
- [:alpha:] Any alphabetical character
- [:blank:] A space or horizontal tab
- [:cntrl:] A control character
- [:digit:] A decimal digit
- [:graph:] A non-space, non-control character
- [:lower:] A lowercase letter
- [:print:] Same as graph, but also space and tab
- [:punct:] A punctuation character
- [:space:] Any whitespace character, including newline and return
- [:upper:] An uppercase letter
- [:xdigit:] A valid hexadecimal digit

- **Subexpressions and Backreferences**

  (abc) matches whatever the expression abc would match, and saves it as a subexpression. Also used for grouping.

  (?:...) pure grouping operator, does not save contents

  (?#...) embedded comment, ignored by engine

  \n where 0 < n < 10, matches the same thing the nth subexpression matched.

- **Branching (Alternation) Operator**

  a|b matches whatever the expression a would match, or whatever the expression b would match.

- **Repeating Operators**

  These symbols operate on the previous atomic expression.

  ? matches the preceding expression or the null string
matches the null string or any number of repetitions of the preceding expression
+ matches one or more repetitions of the preceding expression
{m} matches exactly m repetitions of the one-character expression
{m,n} matches between m and n repetitions of the preceding expression, inclusive
{m,} matches m or more repetitions of the preceding expression

**Stingy (Minimal) Matching**
If a repeating operator (above) is immediately followed by a ?, the repeating operator will stop at the smallest number of repetitions that can complete the rest of the match.

**Lookahead**
Lookahead refers to the ability to match part of an expression without consuming any of the input text. There are two variations to this:
(?=foo) matches at any position where foo would match, but does not consume any characters of the input.
(?!foo) matches at any position where foo would not match, but does not consume any characters of the input.

**Unsupported Syntax**
Some flavors of regular expression utilities support additional escape sequences, and this is not meant to be an exhaustive list. In the future, gnu.regexp may support some or all of the following:
(?!mods) inlined compilation/execution modifiers (Perl5)
\G end of previous match (Perl5)
[.symbol.] collating symbol in class expression (POSIX)
[=class=] equivalence class in class expression (POSIX)
s/foo/bar/ style expressions as in sed and awk (note: these can be accomplished through other means in the API)

**Java Integration**
In a Java environment, a regular expression operates on a string of Unicode characters, represented either as an instance of java.lang.String or as an array of the primitive char type. This means that the unit of matching is a Unicode character, not a single byte. Generally this will not present problems in a Java program, because Java takes pains to ensure that all textual data uses the Unicode standard.

Because Java string processing takes care of certain escape sequences, they are not implemented in gnu.regexp. You should be aware that the following escape sequences are handled by the Java compiler if found in the Java source:
\b backspace
\f form feed
In addition, note that the \u escape sequences are meaningful anywhere in a Java program, not merely within a singly- or doubly-quoted character string, and are converted prior to any of the other escape sequences. For example, the line
\n gnu.regexp.RE exp = new gnu.regexp.RE("\u005c n")\; would be converted by first replacing \u005c with a backslash, then converting \n to a newline. By the time the RE\n constructor is called, it will be passed a String object containing only the Unicode\n newline character.

The POSIX character classes (above), and the equivalent shorthand escapes (\d, \w and the like) are implemented to use the java.lang.Character static functions whenever possible. For example, \w and [:alnum:] (the latter only from within a class expression) will invoke the Java function Character.isLetterOrDigit() when executing. It is always better to use the POSIX expressions than a range such as [a-zA-Z0-9], because the latter will not match any letter characters in non-ISO 9660 encodings (for example, the umlaut character, "ü").

Reference Material

- **Print Books and Publications**

- **Software Manuals and Guides**
  perlre(1) man page (Perl Programmer's Reference Guide)
  regcomp(3) man page (GNU C)
  gawk(1) man page (GNU utilities)
  sed(1) man page (GNU utilities)
  ed(1) man page (GNU utilities)
  grep(1) man page (GNU utilities)
  regexp(n) and regsub(n) man pages (TCL)